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Publisher 2000 Workshop 

 
 
 
This workshop will introduce you to the basics of desktop publishing, including how to 
work with text, graphics and tables.  Emphasis will be given to steps in making flyers, 
brochures and newsletters.  You will learn design techniques and skills you never knew 
you had…without requiring any formal graphic design or experience! 
 
Let’s get started… 
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Start Publisher 
 
To start Publisher, using the mouse, click the Start Button at the bottom left of your 
Windows desktop screen.  Now select Microsoft Publisher from the Programs menu.  If 
you are unable to locate Microsoft Publisher in the program menu, there may already be a 
shortcut icon on the Windows desktop screen for quick access to the program. 
 
Catalog Screen 
 
The first screen you see when you start Publisher is the Catalog screen.  Notice there are 
three tabs in this screen. 
 

•  Publications by Wizard 
•  Publications by Design 
•  Blank Publications 

 
 
We will take a closer look at these tabs later.  First, it is important for us to review the 
Publisher window.  To clear the Catalog screen, click the Exit Catalog button, and the 
main Publisher workspace appears. 
 
The workspace is divided into two parts:  1-) The Quick Publication Wizard appears in 
the left portion of the screen, and 2-) the main workspace (where you create and work on 
the publication) appears on the right portion of the screen. 
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Wizards 
 
Wizards are used to simplify utilization of programs.  The Publisher wizard offers 
assistance in creating about any type of publication you can imagine.  You choose a 
category like newsletter for example, and the wizard creates one with all the basic 
elements of a good newsletter.  Once the basic publication is created, the wizard pane 
stays open on the screen.  To hide the wizard, click the Hide Wizard button. 
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Office Assistant 
 
The Office Assistant is a help system.  To access the Office Assistant, click the Help icon 
on the standard toolbar or press F1 on the keyboard.  The Office Assistant appears with a 
box in which you can type a question or keyword pertaining to the topic with which you 
need assistance. 
 

 
 
 
If you choose to hide or clear the Office Assistant from the screen while you are working, 
you can right-click the animated assistant and choose Hide on the menu. 
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 1 - Standard toolbar 
 2 - Control Menu Box 
 3 - Title bar 
 4 - Menu bar 
 5 - Rulers 
 6 - Objects toolbar 
 7 - Status bar 
 8 - Displays/Hides Wizard 
 9 - Page icons (helps you select and move to pages) 
10 - Object position 
11 - Object size 
12 - System tray (contains peripheral icons) 
13 - Workspace page 
14 - Scratch area/workspace 
15 - Vertical scroll bar 
16 - Office Assistant Clipit 
17 - Minimize program 
18 - Resizing buttons 
19 - Close window/program 
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Where to Begin? 
 
Publisher is different when it comes to applying data to the program.  For example, Word 
processing programs, such as MS Word, are set up in a linear fashion.  Words follow 
words, lines follow lines, and paragraphs follow paragraphs.  On the other hand, desktop 
publishing programs, such as MS Publisher, are object-based.  You can arrange objects 
on the page to create a specific design or effect.  
 
There are four types of objects used when working with a desktop publishing program. 
 

1. Text or Table Object 
2. Picture Object 
3. Drawing Object 
4. OLE Object 

 
Text or Table Object – This type of object contains text.  It might be a heading, an article 
in your newsletter, or a table.  Anywhere in your publication that you want text, you 
create a text or table object.  In this type of object, you can type text directly or import it 
from another source like a word processing file. 
 
Picture Object – This type of object contains any type of graphic imported from another 
source.  Examples:  clip art, scanned images, or pictures created in another program such 
as Corel Draw or Microsoft paint. 
 
Drawing Object – This type of object includes visual items you create in Publisher such 
as lines or Custom Shapes.  This is the only type of object that doesn’t have a container 
or frame. 
 
OLE Object – This type of object contains a file created by another program and 
embedded in a Publisher document so that you can use the original program to edit it 
without exiting Publisher. 
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Create a Text Frame Object 
 
Now!  Let’s do a brief exercise working with an object: 
 
On the objects toolbar, click the Text Frame tool.  The cursor changes to a crosshair. 
 
Click and drag in the document to create a text frame.  When you finish dragging, the 
frame looks like a box with a light gray line around it.  The gray line is an onscreen 
boundary – it doesn’t print.  Inside the frame is a blinking cursor, which indicates the area 
ready to accept the insertion of text.  Type a few words. 
 
Notice that there are rectangular dots on the frame – the dots are called selection handles.  
They indicate the object is selected.  They are also used to resize the object. 
 
There are two ways to insert text into Publisher:  1-) type it or 2-) import it from another 
document.  
 
To type it, create a small text frame near the top of the page by clicking the Text Frame 
Tool on the objects toolbar.  Type a short headline like, “Come One, Come All!”   
 
Now, let’s try importing text.  Open Notepad, the text editor that comes with Windows.  
Click the Start button – then click Programs – then Accessories, and finally, Notepad.   
 
Type the following: 
 

This is text to be imported into a Publisher document.  Text can be edited 
after it’s been imported into Publisher, just as it can be within a word 
processing document.  You can change fonts, create intents, add borders 
and add fills to any text frame. 

 
Save the text by selecting the File – Save options from the menu bar.  Name the 
file “SampleText” then click the Save button.  Close Notepad.   
 
Now create another small text frame in Publisher.  Be sure the text frame is 
selected and choose Insert - Text File from the menu.  The insert text dialogue 
box appears.  This dialogue box should look familiar to you – it looks a lot like 
the Open dialogue box and the Save As dialogue box. 
 
Find the text file you just created, select it then click the OK button.  If there’s too 
much text for the text frame, you will see a small rectangle at the bottom of the 
frame, which contains A…   This is called the auto-flow message.  If all the text 
fits within the frame, you will not see this.  The process of importing a file is the 
same.  (Refer to page XX for connecting frames that contain an overflow of text.) 
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Applying a Border 
 
So now we have a text frame with contents.  Formatting can be applied to the text 
just as in a word document.  The text frame can also be formatted.  The first way 
to format the frame is to add a border around it.  Although you may already see a 
boundary around the text that resembles a border, it doesn’t print on the 
document.  To add a simple border, do the following: 
 

1. Select the text frame. 
2. Select Frame – Line/Border Style from the menu bar.  The submenu that 

appears displays a couple of thicknesses and some other options.  Click on 
one of the line thicknesses to add a border. 
 

To add a custom border: 
 

1. Select the frame again. 
2. Select Frame – Line/Border Style – More Styles from the menu bar.  

The Border dialogue box appears. 
3. On the Line Border tab, you can select one of the standard line 

thicknesses, or you can type in another point size for a custom line.  Select 
one and look at the preview. 

4. To have the border appear only on the top and bottom of the frame, in the 
preview pane, click the left side of the frame to select it.  You’ll know it’s 
selected when you see arrows appear at the top and bottom of that side 
only. 

5. Click None under Choose a Thickness to remove the line from the side 
you selected. 

6. Now do the same for the right side of the frame. 
7. Let’s make the top border a different color.  Click the top side of the frame 

and choose another color from the Color dropdown list. 
8. Click OK to see the text frame with your customer border. 

 
A different color can also be added to the area within the text frame border.   
 

1. Select the text frame you want to format. 
2. Select Format – Fill Color from the menu bar then click a new color from 

the scheme colors. 
3. Click OK. 
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Using Object Layout Tools 
 
Now that we have an object, it can be placed anywhere we want it on the page.  
Since objects contain information that makes up the publication, positioning the 
object is as simple as dragging it wherever you want it.   
 
Publisher provides tools called layout guides and snap to that ensure all of the 
objects are aligned with one another for a pleasing appearance.  Activating Tools 
- Snap to Ruler Marks from the menu bar makes text frames and other objects 
jump in small increments when they are moved.   The increments are the smallest 
tick-mark on the ruler displayed at the top and left of the pane.  And activating 
Tools – Snap to Guides means objects will jump to the page guidelines you 
establish. 
 
Let’s try positioning a few frames within your publication using these features.   
 

1. Ensure the snap to feature is activated then, create a few text frames with 
one or two words to add some emphasis to the page – like, “New!” 
“Improved!” or “Coming Soon!” 

2. Drag each text frame one below the other to the guideline at the left 
margin just below the headline we typed earlier. 

3. Now drag the frames in a horizontal line so their tops line up.  The Snap to 
Ruler Marks should make it easy for you to align them. 
 

You can change the margin guidelines and/or create additional guidelines on the 
page to create a grid that can be used to align all the objects.   
 

1. Select Arrange – Layout Guides from the menu bar.  The Layout Guides 
dialogue box appears. 

2. To change the margin width, type new measurements in the Margin 
Guides fields. Or you can click the up/down arrows to change the value. 

3. To add guidelines, type a new number of columns and rows or click the 
up/down arrows to change them.  Publisher will add equally spaced 
guidelines to divide the page into the number of columns and rows you 
specify. 



 11

Enhancing the publication with Graphics 
 
 
Drawing Objects 
 
Initially, a reader’s attention is drawn to the publication by its pictures and 
their captions.  Then, they will most likely read the headlines.  Drawing 
Objects is one form of graphics that is used with Publisher.  To create a 
drawing object, you don’t have to be artistic.    First, let’s look at the Line 
Tool, Oval Tool and Rectangle Tool on the objects toolbar. 
 
   Line Tool 

    
Oval Tool 
 
 
Rectangle Tool 

   
  

 
 

1. Click on one of the tools, and then click inside the 
publication.   Now try drawing with the other two.   
If you hold down the Shift key while drawing these 
tools the Line Tool will create lines at 0, 45 and 90 
degree angles; the Oval Tool creates perfect circles; 
and the Rectangle tool creates perfect squares. 

 
2. There is another tool on the objects toolbar called 

Custom Shapes.   Clicking this button reveals a pop-
up box with a variety of shapes on it.  Click on any 
one of the custom shapes then click and drag in your 
publication to create it. 
 

Custom shapes are different than the usual straight line, oval 
and rectangle shapes because they not only offer more 
variety, but many of them allow you to adjust certain things 
about their shape.  They are outlines of shapes that can be 
enhanced with borders, box shadow, fill colors, patterns, 
and much more. 

 

Objects 
Tool Bar 
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Clip Gallery 
 
Inserting a clip art picture in your publication is simply a matter of drawing a clip 
art frame, then selecting the picture you want from the Clip Gallery. 
 

1. Select the Clip Gallery Tool from the objects toolbar, then click and drag a 
frame in the publication.  The Insert Clip Art dialogue box automatically 
opens. 

2. Click on the Pictures tab.   
3. Click on one of the pictures and a pop-up appears.  The first button on this 

pop-up inserts the clip into your publication.  The second one shows a 
larger preview of the selected clip. 

4. Insert the clipart into the publication by clicking on the Insert clip button. 
 
 

Pictures 
 
You can insert a variety of graphic image formats into a publication.  

 
 

Let’s create a bitmap file to see how this is done.  We’ll capture a screen to 
demonstrate this. 
 
1. Select File – Open from the menu bar to bring up the Open Publication 

dialogue box.   
2. Now press and hold the Alt key while you press the PrntScrn key.  This 

keystroke combination copies the active dialogue box to the Windows 
clipboard.  Now click the Cancel button to close the dialogue box. 

3. Now open MS Paint.  Start – Programs – Accessories. 
4. The white area in Paint is the bitmap area.  Click the selection handle in 

the bottom right corner and drag to make the bitmap area very small, about 
an inch square.   

5. From the menu bar, select Edit – Paste. 
6. A message pops up asking if you want to enlarge the bitmap area.  Click 

Yes.  You should now have a picture of the Open Publication dialogue 
box. 

7. Select File – Save from the menu.  Name the file Samplebitmap, select 
the location where you want the file saved, and click the Save button. 

8. Close Paint. 



 

9. Now return to the publication and select the Picture Frame Tool on the 
objects toolbar. 

10. Click and drag in your publication to create the frame. 
11. Select Insert – Picture – From File from the menu bar or you can simply 

double-click the picture frame.  The Insert Picture dialogue box appears. 
12. The Insert Picture dialogue box looks and works very much like the Open 

Publication dialogue box.  Find the bitmap file that was just created, 
highlight it, and then click the Insert button to put the picture in your 
publication. 

There may be occasions when you use a graphic that needs modification.   
  

 
Crop
desi
does
 
To c
 

1

2

3

 

 

Crop button 
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ping a graphic allows you to trim away portions of t
red.  Even though this causes the area to not be visib
 not remove it - it simply conceals it. 

rop a graphic: 

. Select the item, the select Format – Crop Picture 
menu or you can click the Crop button on the form
cursor now changes to a crop tool symbol. 

. Grab on of the selection handles on the item, then
off the part of the picture you don’t want.  If you 
handle, you’ll crop two sides at once proportiona
handle will crop just that side of the object. 

. Use the Original size check box on the Scale Pict
restore it. 
Formatting Toolbar
he graphic that are not 
le, trimming the area 

(or Crop Object) from the 
atting toolbar.  The 

 drag the handle to cut 
drag from a corner 
lly.  Dragging a side 

ure dialogue box to 
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WordArt 
 

The easiest way to learn how to use WordArt is to just do it.   

 
 

Rotate objects 
 

1. To rotate a graphic or object, select the item. 
 
 

 
 
 

 
2. On the Formatting toolbar, click the Rotate Left

rotate the item 90 degrees, or if you prefer to do
Custom Rotate button on the Standard toolbar.  
dialogue box appears.  (This can also be access
Rotate or Flip menu. 

 

Rotate Left 
Rotate Right 

 

WordArt Frame Tool 

1. Select the WordArt Frame Tool on the Objects toolbar, then click 
and drag in your publication to create a frame.  The WordArt 
program opens automatically. 

2. The frame you drew now contains the words “Your Text Here,” and 
directly below is a small window with the same phrase.  You will 
insert the desired text into the small window.  Type, “Attention! 
Attention! Attention!” 

3. Click the Update Display button to see the new text in the frame. 
 
Click the Shape field (the first field on the toolbar) to see a dropdown of 
shapes from which you can choose.  Click one to select it and look at the 
change that occurs in your text.  Try several of these shapes and decide on one
that you like. 

Objects 
Tool Bar 
Custom Rotate Button 
 

 or Rotate Right button to 
 a custom rotate, click the 
The Custom Rotate 
ed from the Arrange – 



 15

 
 

3. Click the left or right button on the Custom Rotate dialogue box or enter a 
specific value in the Angle: field. 

 
 

Flip objects 
 

1. To flip an object, select the item 
2. Click on one of the flip buttons on the formatting toolbar, Flip Horizontal 

or Flip Vertical.  (This can also be accessed from the Arrange – Rotate 
or Flip menu.) 

 

 
 
 
 
 

Merging Graphics and Text 
 
Merging graphics and text really isn’t difficult.  The key thing to keep in mind is 
that objects in Publisher stack up in layers and you need to plan what goes on top.  
 

1. Create two or three clip art items. 
2. Move these items and the graphics we created earlier to the center of the 

publication so that the corners of the objects overlap. 
3. Select on of the items and the select Arrange – Bring to Front.  That 

item is now in front (on top) of all the others. 
4. Next, try Arrange – Send to Back.  Now the item is behind (under) the 

others. 
 

Publisher will keep from hiding text in an object.  When you place a clip art, 
picture frame, WordArt frame, or even another text frame on top of a block of 
text, the text will move out of the way. 

Vertical Flip    Horizontal Flip 



 
Wrapping Text Around a Frame 
 
For an added effect, you can make the text flow more closely to the outlines of the 
graphic image.  Two buttons on the Formatting toolbar control text wrap, the 
Wrap Text to Frame button and Wrap Text to Picture button. 
 

Edit Irregular 
Wrap button 
 
Wrap text to 
Frame 
 
Wrap text to 
Picture 
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Wrap Text to Frame causes text to wrap around the perimeter of a picture’s 
frame—usually a rectangle; and the Wrap Text to Picture causes text to wrap 
around the picture—usually an irregular shape.  To do this, click an image 
included in a text area to select it, and then click the appropriate wrap text toolbar 
button. 
 
If you don’t want the text to wrap around an object, there are two ways to stop 
this from happening.  1-)  Move the object behind the text by selecting the object, 
then selecting Arrange – Send to Back; or 2-) turn the wrapping feature off.   
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To turn the wrapping feature off: 
 

1. Select the text frame, the select Format – Text Frame Properties from 
the menu bar. 

2. Under the Options group box, clear the Wrap text around objects check 
box, then click OK. 

 
Not all figures have rectangular shapes.   By using the Edit Irregular Button you 
can display and edit the handles surrounding irregularly shaped figure.  Select the 
image, then click the Edit Irregular Wrap Button on the formatting toolbar.  You 
can add or delete handles by pressing and holding the Ctrl button on the keyboard.  
Click and drag any handle so that the text wraps with the objects shape. 
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Working with Tables 
  
Basically, tables are made up of three things:  columns, rows and cells.  Rows are 
horizontal lines of information, and columns are vertical lines of information.  
Cells are the “squares” of information that result when rows and columns 
intersect. 
 

 
 

To create a table: 
 

1. Click the Table Frame Tool on the objects toolbar.  Your 
cursor will turn into a cross-hatch pointer (looks like a + 
sign). 

2. Click and drag the pointer to draw the table.  The Create 
dialogue box appears.  

3. In the number of rows box, enter the number of rows you 
want the table to have.  (Enter 5 for this exercise.) 

4. In the number of columns box, enter the number of columns 
you want the table to have.  (Enter 5 for this exercise.) 

5. In the Table format area, choose the type of table formatting 
you want.  (Choose List 1 for this exercise.)  Then, click 
OK.  

 
Notice that even though we chose a format that has only 
horizontal lines, Publisher shows vertical lines on the table.  
They are dashed gridlines while the horizontal lines are solid.  
The gridlines are Publisher’s way of helping you determine 
where one cell ends and another begins.  Many functions used 
when working with tables involve selecting all or part of it. 

 

Objects 
Tool Bar 

Table 
Frame  
Tool 
Button 
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To select an entire row, move the pointer over the gray row button directly to 
the left of the row you want to select.  When the cursor changes to a hand, 
click the button and the row is selected. 
 
To select an entire column, move the pointer over the gray row button 
directly above the column you want to select.  When the cursor changes to a 
hand, click the button and the column is selected. 
 
To select an entire table, move the pointer over the gray button at the top left 
corner of the table.  When the cursor changes to a hand, click the button and 
the table is selected. 
 
To select an empty cell (a cell with no text inside of it), simply click inside 
the cell.  The cursor appears in the cell indicating it is selected. 
 
To select any rectangular combination of cells, columns or rows, move the 
pointer and click inside a cell.  Click and drag the pointer over adjacent cells 
to select them. 
 
Entering text in a table is simple.  Place the cursor in a cell.  The cell 
containing the cursor is known as the “active cell.”  Now, simply type the 
desired contents.  All text will appear in the selected cell only.  You must use 
the tab key to move to another cell. 
 
To insert or delete a new column or row: 
 
1. Select the cell next to where you want to insert the column or row.   
2. Select Table – Insert (or Delete) Rows or Columns.  The Insert dialogue 

box appears. 
3. In the Options area, click the circle next to Before selected cells or After 

selected cells depending on where you want the row or column to be 
inserted. 

4. Click Apply to complete the process. 
 
To delete an entire table from the document, select the table, and then select 
Edit – Delete Object. 
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Manipulating Cells 
 
Cells within a table can be merged to make the cell larger or split to make it 
smaller.  
 
To merge two or more cells either vertically or horizontally, select the two 
cells then select Table – Merge Cells. 
 
To split a cell, select the cell, and then select Table – Split Cells.  Publisher 
will split the cell according to the way the rows and columns are situated in 
the table. 
 
When creating calendars, you may need to split a cell diagonally to reflect the 
last day of the month sharing the same day with previous week.  Publisher 
allows you the option of splitting a cell diagonally.  You do this by selecting 
the cell, and then select Table – Cell Diagonals.    This opens the Cell 
Diagonals dialogue box.  Click the circle nest to Divide down or Divide up 
depending on which direction you want the diagonal line to go.  Click OK.  
To remove the division, you would select No division in the Cell Diagonals 
dialogue box. 
 
Changing the Appearance of Tables 
 
There are two main ways to format the table:  1) using the AutoFormat 
feature, or 2) formatting the table’s components separately. 
 
AutoFormat allows you to choose among pre-defined table styles. 
 
1. Select the table and then Table – Table AutoFormat.  The AutoFormat 

dialogue box appears. 
2. In the Table format area, scroll down the list of formatting options.  As 

you select a style, the Sample area provides you with a preview of how the 
table will look. 

3. You can also choose to apply only some of the attributes of the style to the 
table.  On the Auto Format dialogue box, click the Options button.  The 
Auto Format dialogue box expands to include a Formats to apply area. 

4. Click in the boxes next to the various options to turn on  (or off) the 
specific formatting.  As you utilize these options, the Sample area 
displays how each will affect the table. 
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Changing the Components of Tables 
 
Fill Color will change a cell’s contents with colors, shades, tints, gradients (color 
that changes within the cell, creating dimension ad a sense of movement), and 
tint. 
 
To change the fill of a cell, select a cell (or cells), and then select Format – Fill 
Color. 

 
The menu that appears displays some basic colors.  You can select one of these, 
or you can choose More Color Schemes or More Colors to select a different color.  
When you select a color, the cell(s) you selected will be filled with that color.   
 
You can also select Fill Effects to access the Fill Effects dialogue box.  On this 
dialogue box, you can choose the style of your fill effect (tints, patterns, or 
gradients).  Notice that if you choose a pattern or gradient, Publisher allows you 
to choose 2 colors:  one for the base and the other for the pattern or gradient. 
 
Shadow adds a gray drop shadow to the perimeter of the table.  You cannot add a 
shadow to an individual cell.  To add a gray drop shadow to a table, select the 
table, and then select Format – Shadow.  
 
Text formatting can be done to text within individual cells by selecting the cell 
and using the Format – Font options as usual. 
 
Basic Line Borders can be customized for individual cells, rows, columns or the 
entire table.   Select the cells, rows, columns or table for which you want to 
customize the borders.  Select Format – Line/Border Style by clicking on it.  
You can also click More Styles to access the Border Style dialogue box.   
 
The Border Style dialogue box has two tabs.  The Line Border tab allows you to 
choose a thickness and color.  Then, click on which sides of the selected cells you 
want the border to appear.  You can also select a preset border style in the Preset 
area.  The second tab on this dialogue box is BorderArt.  This feature lends itself 
more to regular text frames with no other divisions (like the table cells) within it.   
 
Cell Margins are the amount of space between a cell’s text and the boundaries – 
or borders – of the cell.  Publisher allows you to adjust these margins for an 
individual cell or many cells.  To adjust the margins of a cell, select the cell you 
want to adjust.  Select Format – Table Cell Properties or click the Table Cell 
Properties button on the formatting toolbar and the Table Cell Properties dialogue 
box appears.  In the Margins area, enter the new left, right, top and/or bottom 
margin widths.  Click OK, and the changes are applied to the cells you selected. 
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Importing a Table into Publisher 
 
A table that has been created in another application (such as Word or Excel) can 
be imported into Publisher.  To import an external table, you must first create a 
table in Publisher.  Then, open the external program and the file that has the table 
you want to import into the Publisher table you just created. 
 
Select the cells you want to copy into the Publisher table.  Copy the information 
to place it on the Windows clipboard.  Now go back to Publisher, and select the 
table you just created in which to place the information.  Select the first cell in the 
newly created table, and paste the cells from the Windows clipboard.  Publisher 
will let you know if the imported information will not fit. 
 
To create a Publisher table for an external table, open the external program and 
the file that has the table you want to import.  Select the cells you want to copy.  
Copy the information to the Windows clipboard, and then go back to Publisher 
and paste the new table into your publication.  When you bring in an entire table, 
the formatting remains as it was in the original file. 
 
Publisher offers a quick and easy way to import Excel worksheets into your 
publications.  First, create a table in Publisher and select it.  Then, select Insert – 
Text File and the Insert Text dialogue box appears.  From the dialogue box, find 
and select the Excel file you want to insert and click OK.  Publisher inserts the 
Excel worksheet in the table. 
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Create a Newsletter 
 
Before you start a newsletter, you’ll save time in the long run if you take time to 
plan it out first.  Write out the planning information and keep it handy wile you’re 
putting the newsletter together, to serve as a guide.  This is especially useful when 
you are working with other people to create the newsletter. 
 
•  Who is the audience?  Try to imagine who will be receiving the newsletter and 

put yourself in their place.  What would you want or expect to see? 
 
•  What is the purpose of the newsletter?  Every good publication has a main 

purpose.  If you don’t keep this purpose in mind as you create the newsletter, 
you will end up with a random mix of information that obviously just takes up 
space. 

 
•  What style so I want to use in creating the newsletter?  Decide if the 

publication needs to be formal and businesslike, or informal and playful.  This 
is determined by answers to the previous questions concerning the audience 
and purpose of the newsletter. 

 
•  How should the newsletter be printed?  Should you do it yourself or have it 

done professionally?  This will help you to decide upon the size and quality of 
paper you will use, as well as the colors you can or cannot use. 

 
•  How is the newsletter to be distributed?  You may need to pass them out at a 

function or event; hand them out at the office; or mail them.  Mailing the 
newsletter requires careful thought to special handling and postage fees that 
could be involved depending on the size of the finished product. 

 
Now that you have a plan and some ideas for the newsletter, it’s time to go to the 
computer and start its design.  When using Publisher you can utilize the wizard or 
create the newsletter from scratch. 
 
First, let’s look at using the newsletter wizard. 
 
Go to the Catalog window by selecting File – New from the menu bar.  Publisher 
displays over thirty different styles of newsletter from which to choose.  Now is 
when you want to consider the newsletters purpose and tone. 
 
When you’ve selected a style, click it and then click the Start Wizard button.  
Publisher automatically creates a fully formatted, four-page newsletter with 
placeholder text that you will replace with your own text.  Notice that the 
placeholder text provides you with lots of built-in tips and suggestions for 
creating the newsletter. 
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If you have the Step through wizard questions option turned on each category 
described below will be presented to you as a separate question.  This feature is 
controlled by selecting Tools – Options, selecting the User Assistance tab, then 
checking or un-checking the Step through wizard questions box. 
 
Introduction – Clicking this category simply displays some tips in the bottom 
pane on using the wizard. 
 
Design – This is were you can choose a different style for your newsletter if you 
change your mind about using the previous one chosen in the Catalog window. 
 
Color Scheme – Here you can choose a color scheme and see Publisher instantly 
apply it to the newsletter. 
 
Inside Page Content – Here you can choose the layout of your two inside pages; 
for example, you can choose to include a calendar or order form instead of 
standard stories.  One of the inside pages must be displayed for this wizard option 
to be available. 
 
Number of Columns – This option lets you select how many columns you want on 
each page of your newsletter.  To select the columns for a page, you must 
navigate to that page. 
 
Insert Page – Here you can click a button to insert more pages in your newsletter.  
When you do this, the Insert Pages dialogue box appears.  Since the newsletter is 
set up for double-sided printing by default, this function will insert two pages; a 
left and right page. 
 
Customer Address – Use this option if you plan to mail your newsletter and don’t 
want to use an envelope.  Publisher will put a panel on the back page of your 
newsletter so you can print an address directly on the newsletter. 
 
One or Two-sided Printing – Here you can decide whether you’ll be printing your 
publication on one side only or on both sides.  Publisher will change your 
publication to optimize it for your choice. 
 
Personal Information – Here you can choose which of your personal information 
to include in the newsletter.  By default, the wizard uses the “Primary Business” 
set of information when creating a newsletter, but you can choose another set.  
Typically, the wizard will place this information on the last page of a newsletter. 
 
Convert to Web Site – The final option on the newsletter wizard lets you instantly 
create a web site from your newsletter content.   
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Now, lets look at Custom Designing a Newsletter from Scratch. 
 
Select File – New from the menu bar.  On the Catalog window, click the Blank 
Publications tab, select the Full Page publication and then click the Create button. 
 
If the Quick Publication wizard automatically comes up, click the Hide Wizard 
button to get it out of the way. 
 
First, you need to set some guides to help place objects on the page.  Select 
Arrange – Layout Guides from the menu bar. 
 
On the Layout Guides dialogue box, select the number of columns and rows 
desired then click OK. 
 
Create a text frame and enter a title for the newsletter.  Format the text in the title 
as you desire.  Now let’s try a new trick.  Do you recall that in WordArt, the Font 
Size field offered an option called “Best Fit”?  You can achieve the same effect in 
a regular text frame by using the AutoFit option.  You have two AutoFit options 
from which to choose: 
 

Best Fit – This option makes the text as large as possible in the current-
sized frame.  If you later resize the frame, the text will decrease or 
increase to accommodate the change.  This option is best for headlines and 
other short text phrases or single words. 
 
Shrink Text on Overflow – This option only changes the text size if the text 
becomes too much to fit within the frame.  Publisher will automatically 
reduce the font size so no excess text is hidden and the text fits.  This 
option is best for stories or other large blocks of text.   

 
Select the title frame, and then select Format – AutoFit Text – Best Fit from the 
menu bar.  The title now stretches to fit your frame. 
 
A sans serif font is often used for headlines and other large text, while a serif font 
is usually used for “body text” (smaller text used in the article or story).  This rule 
is reversed when designing online text, such as in a web page. 
 
Serif fonts have rounded ends or curls called serifs at the ends of each letters 
stroke while “sans” (which means without) serif have straight ends for its letters.  
An example of serif is Times New Roman (as this document was prepared using) 
and Garamond.  Examples of sans serif are Arial and Century Gothic as I have 
changed each word to reflect a font example of itself so you can see the 
difference. 
 
You can now design your newsletter by adding text boxes, tables, clipart, 
graphics, etc. You can even use the object toolbar tools to add to its appearance.  



 

Compare your design to other newsletters, magazines and newspapers you have 
lying around and adapt ideas from them that could be added to your document to 
enhance its appearance.   
 
I’d like to take this opportunity to mention the two-font rule—you should 
generally use no more than two different types throughout the document.  Any 
more will cause it to appear too busy and distract from its contents.  Use other text 
formatting attributes for the text to enhance its appearance (e.g., bold, italics, 
sizes, small caps, drop caps to name a few).   The easiest way to keep your fonts 
organized and consistent in a newsletter or any other publication is by creating 
text styles and applying them when you need them. 
 
Similarly, too many colors make a publication seem inconsistent and even sloppy.  
The easiest way to ensure good color usage is to select a color scheme and decide 
ahead of time on specific purposes for the colors. 
 
Add Pages to a Custom Designed Newsletter 
 
Select Insert – Page from the menu bar and the Insert Page dialogue box 
appears.  Note that this is a different dialogue box than the one seen when 
inserting a page using the newsletter wizard. 
 
From the Insert Page dialogue box you can designate the number of pages you 
wish to have inserted; whether they should be inserted before or after the current 
page; and if the new pages are to be blank pages (under the Options section).  
Only the layout guides will appear on the inserted blank pages as they are applied 
throughout a publication when they are initially established.   
 
Connecting Frames within a Newsletter 
 
Connecting frames is a simple way to position text where you want it, even if it is 
not all together on a page or if it is not on the same page at all.  Continuing a story 
on another page is normal when designing newsletters and the text will flow 
easily by using connected text frames.   
 
 
The Text in Overflow button   
indicates that there is an overfl
visible within the confines of t
in the frame can be continued 
Pointers to continue the text in
the continued text are linked to
A…
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 at the bottom of a text frame  
ow of text.  That is, all of the text cannot be made 
he text box.  Text that cannot be seen or does not fit 
by using the Pitcher Pointer and Pouring Pitcher 
to other text frames.  Text frames that are used for 
 their “continued from” or previous text frame.  
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Click the Connect Text Frames button on the Standard toolbar as shown above.  
Your pointer now changes to a “Pitcher of text” that can be poured into a 
continued text frame location.  When you place the pitcher over the continued text 
frame, it changes to a “Pouring Pitcher of text,” indicating that you can now pour 
the text into the continued frame.  Click the continued frame with the pouring 
pitcher pointer and then press the F9 key on the keyboard.   
 

 
 
 

Text Overflow 
Button 



 28

 
 
 
 
 
 
 

Continued on and Continued from notices can be added to linked text frames.  
These notices will automatically insert the correct page number reference where 
the connected text frame is located.  Publisher automatically updates these 
references if you move the text frame.  You create a Continued on notice by 
modifying the text frame’s properties. 

 
 
 
 
 
 
 
 
 
 
 

Go to Next 
Frame Button 

Go to Previous 
Frame Button 
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1. Click Format on the menu bar, and then click Text Frame Properties.  The 
Text Frame dialog box opens. 

2. Check boxes in the Options area of the Text Frame Properties dialog box 
create the Continued on - Continued from notices. 
 
 

When you have several connected frames, you can easily select all the text 
in this chain of frames by choosing Edit>Highlight Entire Story from the 
menu bar.   
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Working with the Background View 
 
In a newsletter, as in many other documents, there is certain text you’ll 
want to have on every page – like the page number, for instance.  You 
could place this text in frames as with normal text, but then you would 
have to be concerned with wrapping, layering, and other issues.  Instead, 
repeating text and graphics can be placed on the background view.  
Objects on the background view show through to the foreground but do 
not interact with any of the objects in the foreground view.  Whatever you 
place on the background view automatically shows up on every page of 
your publication. 
 
You can place text, graphics and any other objects on the background, but 
keep in mind that these can still be covered up by solid objects on the 
foreground.  You’ll want to place background objects in areas you don’t 
usually use in the foreground  - for instance, in the margin area. 
 
Adding a footer line and page number on the background 
 

1. From the menu bar, select View > Go to Background.  It appears 
as if all the objects on your page disappear because all you see now 
is a blank page and any of the layout guides you have established. 

 
Tip:  You can press Ctrl + M to switch quickly between the 

background and foreground views. 
 

2. Using the Line Tool, draw a line just below the bottom page 
boundary, from martin to margin. 

3. Format the line to a 2 point thickness. 
4. Draw a small text frame, centered just below the line. 
5. With the frame still selected, choose Insert > Page Numbers from 

the menu bar.  Publisher inserts what looks like a number sign (#).  
This is a field that will update on each page to show the correct 
number. 

6. Select center alignment for the page number in the frame. 
7. Select View > Go to Foreground from the menu bar to return to 

Publisher’s normal view. 
 
Now, you should see the line and page number below the other objects on 
the page.  The line and appropriate page number will now be reflected on 
every page in the publication. 
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How to Create a Watermark 
 
A watermark is a very faint picture that appears behind other objects on a page.  It 
is used in the background of a publication.   
 

1. To create this effect, press Ctrl M to go to the background view.    
2. Click the picture frame tool button on the objects toolbar, and then drag 

the pointer to create a Picture Frame.  
3. Right-click the picture frame, point to Change Picture, point to Picture, 

click From File and locate the picture to want as the watermark.   
4. Click Insert and the image appears in the frame in the page background 

view. 
5. Right-click the image, point to Change Picture, and then click Recolor 

Picture.  The recolor picture dialog box opens.  Choose a light color so the 
picture will appear faintly on the page.  This allows the picture to show 
through the objects and text in the foreground view. 

 
 

 
   

Piano watermark image behind text object. 
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Drop Cap 
 
A drop cap is when the first letter of a paragraph has a larger, fancy letter 
style than the other text.  The use of a few well-placed drop caps in a 
publication can provide a professional look to it.  To create a drop cap: 
 

1. Click the paragraph where you want the drop cap to be contained. 
2. From the menu bar, select Format > Drop Cap, and the Drop Cap 

dialogue box appears. 
3. In the Available drop caps pane, browse through the preformatted 

drop caps using the scroll bar to see them all.  Click one to see it 
up close in the Preview pane. 

4. When you find one that you like, simply click OK to apply it in 
your publication. 

 
Grouping Objects 
 
Grouping means selecting two or more objects and “gluing” them 
together.  They can then be moved, rotated, and resized just as if they were 
one single object. 
 

1. Place three objects on a blank page. 
2. Press and hold the Shift key on the keyboard and click the three 

objects.  (All three images should be selected.) 
3. Line up the objects by selecting Arrange > Align Objects from 

the menu bar. 
4. The Align objects dialog box will open.  Click the Top to bottom -  

Centers option. 
5. Click the Group Objects button and the three objects are 

transformed into a single selected object. 
6. To ungroup the objects, click the Ungroup Objects button, then 

press the F9 key on the keyboard. 
 

  Click to Ungroup Objects 
 

 Click to Group Objects 
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